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INTRODUCTION     

Use of this instrument is allowed only by qualified users after receiving training by a staff member. Do not run this 

instrument without approval from IMSERC staff. Failure to do so may cause damage to the instrument, produce 

invalid data, and result in additional fees and/or removal of all IMSERC privileges. This set of instructions is meant 

to serve as a guide for ‘routine’ data collection on the instrument. For custom experiments that are not covered 

in this user manual, contact a staff member. For the full list of modes, capabilities, and potential custom 

experiments that could be run on this instrument, please either contact a staff member or check the 

corresponding capabilities section at http://imserc.northwestern.edu/pcm-instruments.html. Please read this 

user manual and acquaint yourself with the instrument. 

A hard copy of this user manual can be found near the instrument. An electronic version of this user manual is 

linked to the desktop of the instrument computer and also available under the corresponding instrument section 

at http://imserc.northwestern.edu/pcm-instruments.html by pressing on the ‘User manual’ button. If while using 

the system, something happens that you do not understand, please stop, and get help. In any event, be completely 

prepared to justify your actions. The cost of even minor repairs could be considerable. 

SAFETY     

All users of IMSERC must review the general safety policies at http://imserc.northwestern.edu/about-

policies.html. To become an independent user of this instrument, you must have the following safety training and 

certificates under your LUMEN profile: 

• Hazardous Chemical Waste Management 

• Laboratory Safety 

• Personal Protective Equipment 

You need the above certificates to be able to reserve time for this instrument on NUcore. Online classes and 

certification are offered at https://learn.northwestern.edu. Upon completion of the certificate, it will take an 

overnight to filter through the different systems and get into the files that NUcore uses. Additionally, familiarize 

yourself with the location of standard safety stations like eye wash and shower stations found in outside of room 

B172 at the north side. Protective eyewear is required in this room, and gloves should be removed when using 

the computer. 

http://imserc.northwestern.edu/pcm-instruments.html#sta
http://imserc.northwestern.edu/pcm-instruments.html#sta
http://imserc.northwestern.edu/about-policies.html
http://imserc.northwestern.edu/about-policies.html
https://learn.northwestern.edu/
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DATA MANAGEMENT     

Your personal data folder is created during training. Please save data under your personal folder, which must be 

located under your supervisor’s group folder, otherwise you might not be able to access your data remotely. See 

a staff member if you do not have a personal folder on this instrument yet. For users that prefer to name their 

data folders using dates, use the order of YYYY-MM-DD or YYYYMMDD in the name, so that folders can be sorted 

chronologically by the operating system if needed. 

Data from this instrument are copied on your group folder on ‘imsercdata.northwestern.edu’ under ‘others/STA’ 

every few seconds. Please follow instructions at http://imserc.northwestern.edu/about-general-faq.html#data 

for details about data access. 

SOFTWARE     

Data acquisition and real time plotting are performed with the ‘MultiVu’ software. Software is installed on the 

instrument computer. For offline analysis after your instrument reservation is complete, please use the following 

resources: 

• Data files with DAT extension are practically Comma Separated Value (CSV) files which can be imported in 

most plotting software 

• For registered IMSERC users, the ‘MultiVu’ software can be downloaded from ‘imsercdata.northwestern.edu’ 

under the folder ‘public/MPMS3’. Software is available for Windows only. Please follow instructions under 

‘Data Access’ at http://imserc.northwestern.edu/about-general-faq.html#data on how to connect to the 

‘public’ folder 

• Remotely via NUWorkspace which is operating system independent. After logging in with your netID 

credentials, please launch the ‘IMSERC’ workspace which contains software 

• You have the option to use the instrument computer for analysis, but you must reserve instrument time 

through NUcore 

DEFAULT INSTRUMENT STATUS     

The default measurement mode of the SQUID is variable temperature and/or magnetic field magnetic 

susceptibility measurements with a Vibrating Sample Magnetometer (VSM). Please notify the appropriate staff 

member well in advance if you would like to run an experiment in a different mode. For the full list of modes and 

http://imserc.northwestern.edu/about-general-faq.html#data
http://imserc.northwestern.edu/about-general-faq.html#data
https://northwestern.apporto.com/
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capabilities, please check at http://imserc.northwestern.edu/pcm-instruments.html#squid. Additionally, put a 

note on your NUcore reservation indicating the preferred mode of your measurement. 

The default working condition of the SQUID is as follows: 

1. Computer screen is by default deactivated. You must start your reservation through NUcore to be able to turn 

on the computer screen. If screen is already on, start your reservation through NUcore 

2. The default ‘SQUID’ user account should be logged in. In case the computer was restarted, the password for 

the ‘SQUID’ account is                            (see hardcopy by the instrument) 

3. Acquisition software (MultiV) should be running. Leave the acquisition software open when you are done with 

the measurement 

4. There should be no error messages on either the front panel of the instrument or the acquisition software. 

Please check the ‘Troubleshooting’ session for a potential solution before reporting the error 

If there is an error or problem with the instrument that is not covered under the ‘Troubleshooting’ section, please 

report the issue by following at least one of the steps below: 

1. If you have already started your reservation using NUcore, please end your reservation and select the error 

reporting option with a brief description about the issue. Place the ‘Stop’ sign near the instrument computer 

to notify users immediately after you. ‘Stop’ signs are located on the shelf above the computers in BG51 

2. If you have not started your reservation using NUcore, please report problems with the instrument at 

http://imserc.northwestern.edu/contact-issue.html and place the ‘Stop’ sign near the instrument computer 

3. Contact a staff member for instructions  

http://imserc.northwestern.edu/pcm-instruments.html#squid
http://imserc.northwestern.edu/contact-issue.html
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MOUNTING AND LOADING A SAMPLE INTO THE INSTRUMENT     

The following procedure should be followed by the users who want to use the default instrument configuration. 

A. MOUNTING SAMPLES 

A variety of sample holders and methods are available to use depending on the form and size of the sample. A 

few precautions should be taken when mounting a sample onto the sample holder to be measured on the MPMS3: 

• Make sure the sample will fit into the chamber. The inside diameter of the sample chamber is 9 mm. The 

sample dimensions should be well below this dimension to avoid rubbing of the sample through the 

sample chamber 

• For the most accurate magnetic moment measurements, measure the magnetic signature of the sample 

holder before mounting the sample. Once the sample is measured the background signal of the sample 

holder will need to be manually subtracted, point-by-point, from the sample measurement 

• Quartz, brass, and plastic straw sample holders are available. In general, quartz sample holders should be 

used for measurement of small magnetic moments. The quartz holders are brittle and fragile but have the 

smaller magnetic signature. For samples having a large moment, the brass sample holders are preferred 

and will have negligible magnetic background and may be easier to handle 

• Mount samples very securely to a sample holder to achieve accurate magnetic moment readings. (GE) 

7031 varnish, or a glue that will withstand the temperature extremes and sample holder thermal 

contraction during the experiment is recommended for bonding the sample to the sample holder. In 

general, 7031 varnish can be dissolved with alcohol or toluene to remove samples and re-use sample 

holders. Do not soak the entire sample holder in solvents like acetone —they will damage the adapter 

that mates the sample holder to the sample rod 

• Mount samples on-axis with the sample rod to minimize dependence of the magnetic moment readings 

on the angular orientation (about a vertical axis) of the sample rod 

 1 
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• Use the sample mounting station to place the sample at the proper location (66±3mm) on the sample 

holder as shown in Figure 1. The sample holder should be placed on the mounting station such that its 

base is aligned flush with the zero-point indicator 

B. LOADING AND UNLOADING SAMPLES 

Once you have mounted the sample on the holder as described in the previous section, next step is to load the 

sample into the magnetometer: 

1. Attach a sample holder with mounted sample to a sample rod. Make sure that the mating surfaces of the 

adapters are clean and that they are screwed all the way in. When screwing your sample holder to the sample 

rod, hold the rod at the blue bearing 

2. Make sure that the temperature in the chamber is above 295 K and below 315 K. Set 

temperature and wait, if necessary, to prevent condensing or freezing air and moisture 

in the chamber. If temperature of the chamber is too high or too low, press on the 

temperature reading at the bottom of the software window and set the target 

temperature to 300K 

3. Select the software menu item “Sample > Install/Remove…”, select the “Change 

Sample” button from the toolbar or the change button in the sequence control window 

(Figure 3). The Install/Remove Sample Wizard begins. It guides you through the rest of 

the sample loading process, including warming the chamber to room temperature and 

venting the chamber, specifying a data file for saving measurement data, entering 

sample and sample holder information, and centering the sample. If you only wish to 

unload a sample, the wizard instructs you how to do this: 

a. Press on the ‘Open Chamber’ button to fill the chamber with Helium 

b. Remove the cap from the sample transport 

c. Remove the installed sample rod if there is a sample left from the last user. Insert 

a new sample rod into the chamber 

d. Replace the cap and press the “load” button on the instrument bezel. 

e. The chamber is purged with helium. You will need to specify a data file and center your new sample to 

perform measurements 

4. After specifying a data file for saving measurement information, the “Sample Properties” window will appear 

and you will be prompted to enter optional information about the sample and sample holder. Selecting one 

 3 
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of the Quantum Design sample holders (brass, quartz, straw) for your measurement will enable the advanced 

feature called “Autotracking”. In this advanced feature the system automatically tracks the center of the 

sample during cooling and warming, based on the predetermined thermal expansion properties of the QD 

sample rod-sample holder assembly. Alternatively, you may unload samples with the procedure below, or 

load samples without specifying data file, sample, or sample holder information. This procedure will not help 

you center your sample either. 

C. CENTERING SAMPLES 

Before initializing a single measurement or a sequence, the sample must be centered within the detector coils. 

During a centering scan, the MPMS3 scans the entire length of the sample transport’s vertical travel path. The 

sample must be centered within the detection coils for accurate magnetic measurements. This can only be done 

if the sample is mounted near the correct location on the sample holder, as described in the above section 

(“Loading and Unloading”): 

There are two different ways to enter the sample offset: “Scan for Sample Offset” and “Enter Offset Manually”. 

The Install/Remove Sample Wizard will scan for sample offset or let you specify the offset value. If you are not 

using the Install/Remove wizard, select “Sample” > “Locate” or select the “Locate” button from the toolbar. 

The sample offset is defined as the distance from the bottom end of the sample holder to the sample location and 

is usually about 66 mm. After a successful centering scan or manual entry of the sample offset, the motor armature 

position should be roughly centered in the window of the sample transport. 

The most accurate technique is to “Scan for Sample Offset”. The software moves the sample through the detection 

coils and analyzes the coil response to locate the sample. The MPMS3 initializes the sample transport by first 

performing a “touchdown” to the lower-travel-limit. The initialization position places the sample far enough below 

the pickup coils that the SQUID does not detect the sample moment. Centering scan parameters are factory 

defined, with the exception of “Scan time”, which can be set from 1-15 seconds. The default centering scan time 

is 4 seconds. However, for larger moment samples, slower scans should be used to avoid software errors in 

reconstruction of DC waveforms. Alternatively, to perform a good centering scan on samples with small moments, 

you may need to induce a magnetic moment > 1x10-7 emu in your sample by applying a magnetic field, or by 

changing the temperature.  

If your sample has a very weak magnetic response and inducing a magnetic moment is undesirable or impossible, 

scanning the sample may not work. Additionally, if your sample does not have a dipole-like response, scanning 
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the sample may not work. In these cases, you can measure the sample offset using the sample mounting station 

before loading the sample and select “Enter Offset Manually”. This is a necessary step to ensure that samples are 

properly centered during measurements.  

Sample offset is the distance measured from the bottom end of the sample holder to the (magnetic) center of the 

sample. When mounting your sample, use the sample mounting station to ensure that the magnetic center of 

your sample falls within the center of the gradiometer coils, at 66 ± 3 mm. 

By scanning the sample before measurements, the user can find the center of the sample in between the pick-up 

coils.  

Scan the Sample 

1. Click “Scan for Sample Offset.” The instrument smoothly 

moves the sample through the detection coils. It may scan the 

sample several times to achieve optimum signal. The user may 

adjust the scan time that it takes the system to center a sample 

2. The signal is plotted in red as a function of position, along with 

a dipole response fit in green. A good scan has one central peak 

with symmetric peaks on either side. The center peak is approximately 170% the magnitude of the outer 

peaks, and opposite in polarity. This is due to the geometry of the detection coils (Figure 2) 

3. The instrument calculates the sample offset based on the fit to the data and asks you for confirmation to use 

the calculated value. Click “OK” only if the fit and calculated sample offset look correct. 

Enter Sample Offset Manually 

Samples with weak magnetic response might need to be centered manually. To do so: 

1. Set the temperature to 305 K and wait for the chamber to reach 305 K. The sample offset you measure at 

room temperature is not valid at other temperatures, due to thermal contraction of the sample rod. If you 

are using the Install/Remove Sample Wizard, it will set the temperature for you 

2. Click “Enter Offset Manually.” 

3. Enter the sample offset you measured. This should be 66±3mm. For accurate measurements, it is important 

to enter the offset as close as possible to the true value. If your sample offset differs from this range, the 

sample should be repositioned on the sample holder.  

 2 
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Automatic Centering  

As the temperature of the sample changes, the dimensions of the sample rod and sample holder will also change, 

moving the sample away from the center of the detection coils. To compensate for this, use “automatic centering” 

to keep your sample centered during experiments. 

There are two automatic centering modes:  

• “Auto-Tracking” adjusts the sample location automatically to compensate for the thermal contraction of the 

sample rod and sample holder. The brass or quartz sample holder must first be specified in the “Sample 

Properties” dialog. Auto-Tracking will generally give the best results and is the preferred setting in the MPMS3 

• You may also disable automatic centering with “No Automatic Centering”. This will reduce the moment 

accuracy and result in slight measurement errors if the chamber temperature changes.  

Specify the automatic centering mode each time you start a measurement or each time you place a measurement 

command or a center sample command into a sequence. The automatic centering setting is found on the “Setup” 

tab in the MPMS 3 Measurement window.  

D. MEASURING SAMPLES 

With DC measurements the sample is scanned up and down at constant speed and the SQUID signal is obtained 

as a function of position and time. The up and down scans are subtracted in position space, giving an 

approximation of the system drift over the time of the measurement. Linear drift is then subtracted from the 

SQUID signal as a function of time, and the raw data is fitted to the dipole response function in position-space. 

The fitting algorithm assumes that the sample magnetic moment approximates a dipole magnetic moment, with 

sign and value remaining constant during measurement. DC Fixed Center and DC Free Center moments are 

calculated for each point, based on the dipole response function. As the names suggest, for Fixed Center the 

center position has been fixed for the fitting routine, and with Free Center, the center position is a free parameter. 

The auto-tracking feature mentioned above is particularly useful for the DC Moment Fixed Center. The auto-

tracking center acts as the seed center position for the DC scan. 

Immediate measurements  
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Immediate measurements refer to the magnetic moment of a sample at a specific temperature or magnetic field. 

Initiate sample measurement with the menu item “Measure” > “Measure…” or by clicking the “Measure” toolbar 

button. Either method will open the Measurement window.  Base system tabs include Setup, DC, VSM, and Graph. 

Setup Tab 

•  Specify “Continuous Measuring” for a continuous stream of data, or “Single Measurement” to collect a single 

data point 

• Specify the SQUID “Ranging” as “Sticky Autorange” (default), “Always Autorange”, or “Fixed Range”. “Sticky 

Autorange” selects the best range for each point while minimizing re-ranging between individual data points. 

“Always Autorange” acquires each data point with the best possible resolution even if the measurement will 

take longer due to the increased range changing operations. “Fixed Range” uses the SQUID range specified by 

the user 

• Specify which automatic centering method is used to keep the sample centered during measurement: “Auto 

Tracking”– Automatically tracks the sample during cooling and warming based on known parameters of the 

sample rod-sample holder assembly. In order to select this option, a Quantum Design supported sample 

holder must first be selected under Sample Properties. Auto Tracking is disabled when using custom sample 

holders. “No Automatic Centering” – Disables automatic centering  

• “Data Logging” allows you to select a *.qmap file to log additional diagnostic information such as gas handling, 

temperature control, and magnet control data. The data will be stored in the measurement data file. This 

differs from the MutliVu log which can be run in the background in addition to your measurement data log 

DC Tab  

• “Scan Length” – Specify the total scan length (in mm). The value entered is the total length of the scan, which 

will be centered about the expected center position of the sample. Scan lengths can be set between 10 mm 

and 60 mm (default: 30 mm) 

• “Scans per Meas.” – The total number of scans (up + down) to be acquired before the data is analyzed to 

calculate the sample moment 

• “Scan Time” – Time (in seconds) for each individual (up or down) scan. In addition to the values available from 

the drop down menu, non-integer values may be entered as well (optimal scan times depend on 

environmental conditions). The default scan time is 4 seconds. However, scan times may need to be adjusted 
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based on the magnitude of your sample moment. For samples with large moments, or time dependent 

magnetization, faster scans may be required 

• “Save Raw Data” – Save raw scan data for each data point (into a separate *.raw file) for later analysis or post 

processing. The raw data file will be saved in the same folder as the measurement data file, under the same 

name as the data file, but with the *.raw file extension.  

Graph Tab 

Shows the up and down scans (black) of the last DC measurement and the mathematical fit to the raw data (green).  

Before clicking “Start” to begin the immediate measurement, temperature and magnetic field can be set by 

selecting “Instrument” > “Temperature…” (or “Instrument” > “Field…”), or by clicking on either the temperature 

or field status bars. Both the system temperature and field control windows allow the user to choose a set point 

and rate, as well as mode of approach. 

For temperature, the stability criteria are: ±0.5K for T > 100 K, and ±0.5% for T < 100K. Field stability is declared 

after the “QuickSwitch” heater has been turned off and the “QuickSwitch” becomes superconducting. 

Automated measurements  

Automated measurements are controlled through sequence files, where operation commands are input by the 

user in a desired order. In addition to measurement commands, several other operations are also available 

through sequence measurements. 

Operation of the MPMS3 can be automated using sequence files. Sequence files are like simple computer 

programs instructing the instrument to carry out a number of operations in a predetermined order. Operations 

typically found in a sequence file include changing the sample’s temperature, changing the magnetic field, and 

measuring the sample’s magnetic moment. Additionally, commands may be placed in sequences to log diagnostic 

data, center the sample, record a comment in the data file, begin recording data to a new data file, generate a 

message on the computer screen, and even run another sequence. 

Create a new sequence file by: 

1. Clicking “New Sequence” or selecting the menu item “File” > “New Sequence.”  

2. Open an existing sequence file for editing by clicking “Open Sequence” or selecting the menu item “File” > 

“Open…” > “Sequence.” You will be prompted to locate the file you want to open. The top of the sequence 
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window shows the sequence file name. An asterisk symbol (*) after the file name means the sequence has 

changed since last time the file was saved. Sequences must be saved before you run them 

3. Save a sequence file by clicking “Save Sequence” or selecting the menu item “File > Save.” If not already 

assigned, you will be prompted for a location and file name 

4. Add a command to the selected sequence by double-clicking the command in the sequence command bar. 

The new command is inserted above the highlighted command in the selected sequence window. You will 

first be presented with a pop-up window to fill in command-specific information. Then a summary of the 

command will appear in the sequence window. More detail about each available sequence command is found 

at the end of this section 

5. Remove and reorganize sequence commands by highlighting them in the sequence window and using the 

“Cut,” “Copy,” “Paste,” “Delete,” and “Undo” commands in the “Edit” menu 

6. Disable commands in a sequence file without deleting them using “Edit” > “Disable”. Enable a disabled 

command with “Edit” > “Enable.” A disabled command will be skipped during sequence execution. Disabled 

commands are preceded by an exclamation mark symbol (“!”) in the sequence window and are changed from 

black text to gray text. With this feature you may decide to execute or not execute some commands just prior 

to run time based on the immediate circumstances. For example, you may wish to disable a series of 

commands that fall outside the meaningful measurement range for certain samples.  

Running Sequences 

If the sequence file you want to run is not open, you need to open it. Open an existing sequence file by clicking 

“Open Sequence”) or selecting the menu item “File” > “Open…” > “Sequence.” You will be prompted to locate the 

file you want to open 

To execute a sequence, it must be the selected sequence. If more than one sequence window is open, make sure 

the selected sequence is the sequence you want to execute. Execute the selected sequence by: 

• Selecting “Run Sequence” or selecting the menu command “Sequence” > “Run” or selecting the “Run” button 

on the control center 

• The status bar and the control center both display the status of the sequence execution. The sequence window 

also highlights the line currently being executed in green 

• The toolbar, “Sequence” menu, and command center all provide the ability to pause and abort sequence 

execution also. When paused, the sequence window highlights the active line of the sequence in yellow. If a 
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sequence is aborted, it will finish its current measurement motion before executing the abort sequence 

command. 

EXPORTING DATA     

Raw data are directly saved in ASCII files with a DAT extension. These files are practically Comma Separated Value 

(CSV) files which can be imported directly into most plotting software 
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PUBLICATION     

A. EXPERIMENTAL SECTION 

Modify the text below according to the setup and conditions you used during the measurement: 

 “Magnetic susceptibility data were collected using a Quantum Design MPMS3 SQUID magnetometer. 

Susceptibility data were collected using a temperature sweeping mode from X to XXX K at YYYY Oe under [zero-

field cooled (ZFC) | field-cooled warming conditions]. A Vibrating Sample (VSM) | DC mode was used for 

measuring the signal.” 
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TROUBLESHOOTING     

A. THE COMPUTER SCREEN WILL NOT TURN ON 

Begin your reservation in NUcore to initiate access to the instrument 

B. COMPUTER REQUIRES LOGIN AND A PASSWORD 

The default ‘MPMS3’ user account should be logged in. In case the computer was restarted, the password for the 

‘MPMS3’ account is                       (see hardcopy by the instrument). See ‘Default instrument status’ section for 

more details.  

C. THERE IS AN ERROR/PROBLEM WITH THE INSTRUMENT THAT IS NOT ADDRESSED UNDER THE 
TROUBLESHOOTING SECTION 

If there is an error or problem with the instrument which is not addressed under the troubleshooting section, 

please report the issue by following at least one of the steps below: 

1. If you have already started your reservation using NUcore, please end your reservation and select the error 

reporting option with a brief description about the issue  

2. If you have not started your reservation using NUcore, please report problems with the instrument at 

http://imserc.northwestern.edu/contact-issue.html add place the ‘Stop’ sign near the instrument computer. 

‘Stop’ signs are located on the shelf above the computers in BG51 and online at the link above. Email or talk 

to a staff member 

3. Email or talk to a staff member 

  

http://imserc.northwestern.edu/contact-issue.html
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REVISIONS     

v1.01 
2026/03/06 

• Release of original version of the user manual for the acquisition software MulitVu v6 

 


